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Introduction 
 
 
StatCalc provides students, teachers, researchers, and managers with an easy to use data analysis tool.  
StatCalc includes 31 statistics modules, four decision tools, an output log, a statistics glossary, and an 
output interpretation guide for each module. 
 
 
Getting Help 
 
Application help can be found in this manual and in the Help module provided with StatCalc.  In addition 
to application help, statistical help is provided in a glossary of statistical terms and definitions. 
 
Uninstalling StatCalc 
 
For Mac versions, drag the program file to the Trash Bin.  For Windows versions, use the Windows 
Control Panel option ADD/REMOVE programs to uninstall StatCalc.     
 

 
 

StatCalc Startup Screen 
 
StatCalc starts by displaying the Statistical Tools module.  There are also tabs for the Decision Tools 
modules and Output Viewer.  Use the Statistical Tools module to select and run statistical analyses. The 
Output Viewer tab stores all analyses conducted after opening StatCalc.  The output from all procedures, 
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including the Decision Tools module, is automatically appended to the output log.  Procedures that use 
spreadsheet data entry present a Y/N column (Yes/No) that allows the deselection of a row for analysis. 
 
 
Example Data 
 
StatCalc includes example data for each statistical and decision tool module.  Click the Example Data 
toolbar button to load data into the fields for the selected statistical procedure. 
 
 
Entering Data 
 
To enter data, point and click on a cell and begin typing. Pressing the right, left, up, or down arrow key 
will save the entry and move the data entry point to the next cell. Pressing the Enter (Return) key will 
move the data entry point to the next row. 
 
 
Copy Data 
 
To copy data from a StatCalc table, select the Copy button on the toolbar.  The copy procedure is 
available for the following statistical procedures:  Frequencies, Descriptives, Weighted means, Goodness 
of fit, Correlation, OLS regression, Logistic regression procedures, and standardized rates. 
 
 
Paste Data 
 
To paste data from a spreadsheet, select and copy the data (make sure the top row has the variable 
names). In the Statistical Tools tab, select the Paste button on the toolbar.  The paste procedure 
replaces all data in the current procedure.  When pasting compatible data copied from other software, 
the data will load from the first (left) column up to the number of columns allowed in a procedure.  As 
an example, Descriptives allows only the far left column while OLS regression allows up to eleven 
columns of data. 
 
This option is available for the following statistical procedures:  Frequencies, Descriptives, Weighted 
means, Goodness of fit, Correlation, OLS regression, Logistic regression procedures, and standardized 
rates.   
 
 
Export Data 
 
Use the File menu to export data into tab or comma delimited text files.  The Export procedure is 
available for the following statistical procedures:  Frequencies, Descriptives, Weighted means, Goodness 
of fit, Correlation, OLS regression, Logistic regression procedures, and standardized rates. 
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Import Data 
 
StatCalc is able to import AcaStat data files and tab and comma delimited text files. Create or export 
delimited text files from most software packages to include word processors, spreadsheets, databases, 
and statistical packages.  StatCalc allows up to 100,000 observations.  
 
There are four ways to import compatible data files for use in Frequencies, Descriptives, Weighted 
means, Goodness of fit, Correlation, OLS regression, Logistic regression procedures, and Standardized 
Rates: 
 
1.  Paste:  Select and copy compatible data in spreadsheet software, select one of the above procedures 
and click paste. 
 
2.  Import File Menu:  Use the File menu to open a compatible file.  Once the file is selected, the Data 
Manager module will appear with a list of variables available for loading into the selected procedure.  
 
3.  Data Cube:  Click the data cube to display the Data Manager module for selecting and opening a 
compatible data file.  The data cube is only enabled when one of the above compatible statistical 
procedures is selected. 
 
4.  Drag and Drop:  Drag and drop a compatible data file or data selected in a spreadsheet into the 
Statistical Procedures tab to immediately load data or drag and drop a compatible data file into the data 
cube.  As with pasting, the data will load from the first (left) column up to the number of columns 
allowed in a procedure.  As an example, Descriptives allows only the far left column while OLS regression 
allows up to eleven columns of data.  For Correlation, OLS and Logistic regression the dependent 
variable must be located in the first data column (left side) of the spreadsheet. 
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Data Manager Module 
 
The Data Manager module contains two tabs: File Manager and Data Limit. 
 

 
 
File Manager Tab:  This tab allows the selection and opening of compatible data files.  Variable names 
from the first row of the file will be displayed.  Drag and drop these variables into the available analysis 
list boxes.  The list box format will change depending on the statistical procedure selected.  As an 
example, in the image above the OLS Regression procedure is selected so the Data Manager will allow 
one Dependent variable and up to ten independent variables to be selected.  Click “Load” to populate 
the data grid in the OLS Regression procedure.  Data Manager will automatically close to display the 
statistical procedure.  If the data file rows (observations) are greater than the default (200 obs), a note 
will be display the new spreadsheet size (click OK to continue).  The imported data will be available for 
all compatible statistical procedures until the file is cleared from memory. 
 
 
Data Limit Tab:  The Data Limit tab affects procedures that allow spreadsheet-like data entry.  When 
importing large data files, the data limit is automatically adjusted to accept up to 100,000 observations. 
StatCalc operations will slow as the data limit is increased.  When StatCalc is closed and reopened, it will 
reset to the default (200 observations).   
 
 
Compatible Data File 
 
A compatible delimited text file will have variable names in the first row.  Each variable name must be 
separated by a tab or comma. The data must start in the second row. Each row represents one 
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observation with one or more variables.  StatCalc comes with example data that provides an example of 
the formatting required.  The delimited text file should be saved as a text file with either a ‘.txt’ file 
extension for tab delimited files and a ‘.csv’ extension for comma delimited files.  Countries that use 
comma decimal delimiters should use tab delimited instead of csv to import or export data.  Do not use 
rich text format (rtf) or any other software specific format such as Microsoft Word or Excel or Apple 
Numbers or Pages. 
 
Below is an example of a comma separated text file.  For another example, you can also copy example 
data from StatCalc and paste it into a spreadsheet or word processor. 
 
IDNum,Name,Age,Sex,Income 
1001,Fred,49,m,56000 
1002,Susan,32,f,64000 
1003,Jill,69,f,32000 
 
 
Stat Guide 

 
Each module has an annotated example of the output to assist with interpretation. The Stat Guide is 
accessed through the Help module. 
 

 



 

StatCalc User Manual 9 

View Menu  
 
The View menu provides shortcuts to the StatCalc modules.  It 
also provides a link to the Calculator module. 
 
 
View Calculator 
 
Open the calculator module via the View menu. The Calculator 
module includes a Calculator Log that stores a record of 
calculations.  The Calculator Log can be exported to the StatCalc 
Output tab for saving, editing, and printing. 
 
To add notes to the Calculator Log, click the Edit button and enter notes. Moving cursor from 
the Calculator Log will lock editing. 
 
Most of the operations are self-explanatory.  The one function that may not be commonly 
available in a calculator is the button allowing the change of a sign. To change the sign, enter a 
value and click the change sign button to change a positive value to negative or negative to 
positive. 
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Statistical Tools 
 
 
The Statistical Tools tab provides 31 statistical tools.   
 

 
 
 
Frequencies 
 
Produces a listing of all the values in a variable, the number of times they occur in the variable, and the 
percent of cases represented in each value.  Frequencies can be produced on numerical and string data. 
A ‘Pareto Sort’ is also provided that lists categories in rank order from the most frequently occurring 
category to the least. 
 
 
Descriptives 
 
Calculates measures of central tendency (mean, median) and variation (variance, standard deviation).  
The Descriptives module requires continuous data.  Enter the data and click calculate when done.  



 

StatCalc User Manual 11 

Weighted Mean 
 
Calculates the mean for a group of means. For each mean, enter the mean and its sample size. Click 
calculate when done.  The output includes the mean if the group of means had not been weighted by 
the sample size. This value is for comparison purposes only.  Do not use the unweighted mean.   
 
 
Z-Score 
 
Calculates the standardized score for a specific value in a distribution represented by a mean and 
standard deviation.   
 
 
Confidence Interval for the Mean 
 
Calculates the confidence interval for the population mean based on a sample mean, standard 
deviation, and given sample size.  The confidence level is adjustable from 80% to 99%.  
 
 
Confidence Interval for the Proportion 
 
Calculates the confidence interval for the population proportion based on a sample proportion and 
given sample size.  The confidence level is adjustable from 80% to 99%. 
 
 
Diagnostic Accuracy 
 
Diagnostic accuracy compares a test result to a dichotomous reference standard. It is used to evaluate 
the sensitivity and specificity of a diagnostic test. The reference and test variables can only be two 
values (usually 0 for non-disease and 1 for disease). The reference variable represents the gold standard 
to compare to the test results.   
 
 
Goodness of Fit 
 
Use this procedure to evaluate the variation in a distribution of categories. Each row in the table 
represents one category among several. For each category, enter the observed count and the expected 
count. Generally the expected count is established by estimating a priori the proportional distribution of 
the categories.  The expected frequency for each category can be obtained by multiplying the total 
observed sample size by the a priori (expected) proportion for each category.  StatCalc calculates the 
standardized residual for each category. A residual of +/- 2.0 or greater suggests that category had a 
substantive impact on the chi-square test statistic. 
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Chi-Square 
 
This procedure presents the association between two categorical variables via a contingency table. Each 
cell in a contingency table represents a subgroup. All the rows and columns provided by StatCalc do not 
need to be used but always start with the top leftmost cell.  Enter counts in each cell and StatCalc will 
calculate for each cell the row percent, column percent, and total percent.  
 
This procedure also automatically produces several contingency table statistics to include the chi-square 
statistic and measures of strength of association.  StatCalc chi-square allows for a contingency table with 
up to six rows and six columns. 
 
 
Z-test One Sample 
 
Used to test for the difference between one population proportion and one sample proportion. Enter 
the population proportion, sample proportion, and the number of observations in the sample.  
 
 
Z-test Two Sample 
 
Used to test for the difference between two sample proportions.  For two sample z-tests, both 
dependent and independent variables must be nominal level variables. 
 
 
T-test One Sample 
 
Used to test for the difference between one population mean (mu) and one sample mean. Enter the 
population mean, sample mean, sample (or population) standard deviation and the number of 
observations in the sample.  
 
 
T-test Two Sample 
 
Used to test for the difference between two sample means.  Enter the population mean, sample mean, 
sample (or population) standard deviation and the number of observations for each sample.  
  
 
One-Way ANOVA 
 
Used to test for the difference between two or more sample means.  Enter the population mean, 
sample mean, sample (or population) standard deviation and the number of observations for each 
sample.   All the rows and columns provided do not have to be used but always start with the top 
leftmost cell.  StatCalc ANOVA allows for up to six categories of sample means. 
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Correlation 
 
Calculates the Pearson correlation coefficient to represent the association between two interval/ratio 
level variables.  Enter the data as indicated and click Calculate when done.  
 
 
OLS Regression 
 
Calculates simple regression (one independent variable) or multiple regression (two or more 
independent variables).  OLS regression requires an interval/ratio dependent variable.  StatCalc OLS 
allows one dependent variable and up to ten independent variables.  The dependent variable must be 
located in the first data column (left side) of the spreadsheet. 
 
 
Logistic Regression 
 
Calculates simple regression (one independent variable) or multiple regression (two or more 
independent variables).  Logistic regression requires a dichotomous (0 and 1) dependent variable to 
develop a model that predicts the occurrence of 1.  StatCalc logistic allows one dependent variable and 
up to ten independent variables.  The dependent variable must be located in the first data column (left 
side) of the spreadsheet. 
 
 
Z Distribution  
 
Enter a z score to calculate the proportion of the probability distribution at or beyond the score entered.  
This procedure is most useful for evaluating the statistical significance of a z-test statistic calculated 
manually. 
 
 
T Distribution  
 
Enter a t score and degrees of freedom to calculate the proportion of the probability distribution at or 
beyond the score entered.  This procedure is most useful for evaluating the statistical significance of a t-
test statistic calculated manually. 
 
 
F Distribution  
 
Enter a f ratio score and numerator and denominator degrees of freedom (consult a statistical 
reference) to calculate the proportion of the probability distribution at or above the score entered.  This 
procedure is most useful for evaluating the statistical significance of an f test statistic calculated 
manually. 
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Chi Square Distribution  
 
Enter a chi-square score and degrees of freedom to calculate the proportion of the probability 
distribution at or above the score entered.  This procedure is most useful for evaluating the statistical 
significance of a chi-square test statistic calculated manually. 
 
 
Epidemiology Rate Statistics   
 
StatCalc provides five common calculations of rates. Select one of the options and enter the data as 
indicated. After entering data, click the Calculate button on the toolbar.  The results will be displayed in 
the StatCalc module and appended to the Output Log for saving, coping, or printing.  
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Epidemiology Direct Standardized Rate 
 
Enter group labels and population values from a standard population model. Enter number of deaths 
and population for each group in the comparison population.  After entering data, click the Calculate 
button on the toolbar.  The results will be displayed in the StatCalc module and appended to the Output 
Log for saving, coping, or printing. 

 
For comparison purposes, groups can be excluded by deselecting a row checkbox. 
 
Data can be copied for pasting into a spreadsheet for saving.  Data can also be copied from a 
spreadsheet for pasting into the procedure.  Data must be formatted to match the module and each 
column should have a variable name.  An example is provided below: 
 

Group   StdPop       D+         Pop      
   <1     1600     1856      358077      
  1-4     6400      245     1365532      
  5-9     7000      147     1547075      
10-14     7000      195     1636034      
15-19     7000      778     1804424      
20-24     7000     1121     1924978      
25-29     7000     1371     1878849      
30-34     7000     1603     1724669      
35-39     7000     2586     1908443      
40-44     7000     3887     2073527      
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45-49     7000     5116     1941822      
50-54     7000     6859     1693684      
55-59     6000    10406     1560711      
60-64     5000    16201     1617467      
65-69     4000    19746     1209237      
70-74     3000    27002     1018781      
75-79     2000    35310      785993      
80-84     1000    41758      531633      
  85+     1000    61875      399177  
 
 

Epidemiology Risk Statistics   
 
StatCalc provides four common calculations of risk. Select one of the options and enter the data as 
indicated. After entering data, click the Calculate button on the toolbar.  The results will be displayed in 
the StatCalc module and appended to the Output Log for saving, coping, or printing. 
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A 2x2 table is displayed for the Relative Risk and Odds Ratio procedures.
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Decision Tools 
 
The Decision Tools tab provides four tools for calculating constant dollars and experimenting with 
decision tables, queuing theory (waiting lines), and price elasticity of demand.  An example is provided 
for each tool.  The results are displayed in the Decision Tool tab and are added to the output log.  A good 
reference text for most of these tools is Fundamentals of Management Science, by Efraim Turban & Jack 
R. Meredith. 
 

 
 
 
Constant Dollars 
 
This tool uses the urban consumer price index (CPI-U) for the United States to adjust for inflation.  The 
module will create and apply an inflation and deflation estimate.  Another price index can be used by 
overriding the default CPI by entering “*” followed by a CPI. 
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Queuing Theory 
 
Queuing theory is used to evaluate the performance of service systems where waiting lines may form 
and customers arrive at random times (i.e., license bureau, tax assessors office, emergency room). To 
evaluate a waiting line, data must be provided for the average arrival rate, average service rate, and the 
number of servicers. 
 
 
Price Elasticity of Demand 
 
This tool uses the change in demand that occurs when a price is changed to estimate price elasticity. 
Given the estimate of elasticity, the tool will attempt to find a breakeven price through iterations of 
price.  Both fixed and variable costs can be included in the model. 
 
 
Decision Tables 
 
Decision tables quantify in table form the impact of decision options under uncertainty.  Tables will 
typically contain the following elements: 
 
1. Alternative courses of action 
2. States of nature 
3. Probabilities of states of nature (must sum to 1)  
4. The payoffs  
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Output Viewer 
 
The Output Viewer tab displays the results of the analysis in a text window for editing and printing.  Each 
time a statistical procedure is run, the results are automatically sent to the output log.  Notes can be 
added to the output before printing or saving.  The Output Viewer opens output saved by StatCalc or 
AcaStat. 
 

 
 
 
The Output Viewer uses Courier font.  This is a fixed font that ensures proper alignment of the tables.  
When copying output to a word processor, the default font may not be Courier in the word processor.  
This will result in tables that are out of alignment.  To correct this, highlight the output in the word 
processor and change the font to Courier.  The font size may also need to be reduced to ensure the 
output fits widthwise on one page. 
 
Right click on the output to display menu options.  The options allow changing of the output font style 
and converting the output by inserting tabs for copying into a spreadsheet.  This conversion improves 
output presentation in a spreadsheet.  Some editing may be required after pasting into a spreadsheet. 
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File Menu 
 
New 
 
Click the "New" button to erase all output.   
 
Open Output 
 
This menu item reopens saved output into the Output Viewer.  It will replace the current Output Viewer 
contents.  
 
Save Output As 
 
This menu item saves all items in the output log into a text file that can be imported into word 
processing software. 
 
Print Output 
 
This menu item prints all output or selected items in the output log.  To select multiple items in the Mac 
version, press and hold the Command key while selecting items in the output log.  For the Windows 
version, use the Control key for the same function.  By default, StatCalc prints a date and time header 
and a Notes section on each page printed.  
 
 
Edit Menu 
 
Cut 
 
Use this menu item to remove selected output text and save the text to the 
system clipboard. 
 
Copy 
 
Use this menu item to copy selected output text to the system clipboard. 
 
Paste 
 
Use this menu item to paste text from the system clipboard into the output screen. 
 
Clear 
 
Use this menu item to delete all output log entries.  The textbox must be selected. 
 
Select All 
 
Selects all the text in the output screen. 
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System Requirements (required minimum)  
 
 
Mac OS X 10.13 or later.  Silicon M1 chip compatible. 
Windows 7 SP1 or later 
 
support@acastat.com 
https://www.acastat.com 
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